
Creating files and forms in Adobe Acrobat Version 7

There are several variations of image compression, font inclusion
and several other variables within PDF files.

There is a menu at the top of the Adobe PDF panel to choose
Default Settings. These are presets of how the resolution of
images in the document are converted in the PDF document,
whether fonts are included, and how compatability with older
versions of Acrobat are selected.

There are six presets, Smallest File Size (Screen in previous
versions), Standard (ebook in previous versions), High Quality (Print
in previous versions) and Press Quality (Press in previous versions)
as well as two new settings with special graphics exchange
features PDFX1a and PDFX3.

Creating files from a document you created.

Acrobat really comes in two parts.  Acrobat itself which is an
application, and Acrobat Distiller, which looks to the user like
a printer.  It's a handy to think of Distiller as a printer, except
what you get out of it is a PDF file rather than a print. There is
also the free Acrobat Reader, which cannot create PDF files.

There used to be a version called PDF Writer that was distributed
with some applications.  Think of it as a crappy printer. It will
create PDF files, but with less accurate reproduction and less
compression.

Windows

In the application you created the document with, select Print.
This dialogue will vary considerably from application to application.

Adobe PDF should be on the list of printers available.

There are three panels: layout, paper/quality and Adobe PDF
Settings.  Layout and paper/quality are common to most printers
and aren’t often used in creating an Acrobat file.

Using the directions in this handout, PDF files can be
created from any application.  In Microsoft Office
applications, if you have Acrobat installed, there will be
a tool bar and a menu item that will modify your

Acrobat settings, create PDF documents and interact with
Outlook by sending PDF’s out for review and comment
without going through the print dialogue.  The resulting
PDF files are exactly the same as printing with Adobe PDF.

Acrobat toolbar

Clicking on Properties will give you options available for Adobe
PDF.  This is normally where you would change page size,
resolution, or select a different tray for special papers.

Creating PDF files from Microsoft Office
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When you select a setting, a brief description is displayed above
the window.

You can edit the settings and save new presets for special
applications you might have.

In order to understand what characteristic the presets affect,
look at what settings you can change.

Click on Edit.

There are six panels: General, Images
Fonts, Color, Advanced and Standards.

Under General, the most commonly changed setting is
Compatibility.  The default value for all the presets in Version
7 are version 5 compatability.  Even though version 4 was
released in early 1999, and version 5 in early 2001, potential
viewers may not have upgraded their version of Acrobat reader,
so for maximum compatibility choose 3.0.  Documents saved
as 4.0 or higher compatible will not show color when viewed
in 3.0.   Version 3.0 compatible files will be slightly larger and
there are limitations to the size of the document and some
issues related to shading styles. In general, the higher numbered
version will create smaller file sizes.  It may be advisable to use
a higher version and advise potential viewers which version of
the reader is required.

Color, Grayscale and Monochrome images are set separately.
To reduce download times, the size of files with bitmapped
images can be reduced by reducing the resolution of the image.
 Reducing the size of files also reduces the sharpness of an
image.  The goal is to keep only as much data as is necessary.
You can also apply various file compression schemes which
reduce the size of the file.  At the most extreme compression
settings (minimum) it can have an effect on the sharpness of
the image.

Most of the time it is desirable to reduce the size of the file but
in some cases, such as preparing files for commercial printing,
it's more important to have the necessary resolution than to
reduce file size.

If your original images in the document are lower than the
resolution specified, no change will occur.

Under the Monochrome images, if the Anti-alias to gray setting
is used, jagged edges will look smoother on screen, but may
make small detail and thin lines blurry.
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There are other settings under General where you can choose
page range if your applications settings don't allow this and set
the default page size for creating PDF files.

The Images panel is where you choose how bitmapped images
are changed in the document to reduce file size.
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The Color panel adjusts settings that are probably only appropriate
for demanding color applications when you are preparing files for
a commercial press.

The Advanced and PDF/X panels have settings that primarily concern
processing of PostScript files when using Distiller as a standalone
application and exchanging graphics data.

Settings characteristics

All the presets in version 7 are set for Acrobat 5.0 compatability. In order
to have the widest possible compatability (at the cost of some file size)
you may wish to modify these presets to Acrobat 4.0 compatability.

The Smallest files size settings preset is used for documents that
will only be viewed on a computer screen.  It is set for Acrobat 5.0
compatibility,  reduces any image over 150 dpi to 100 dpi and subsets
the fonts.

The Standard setting preset is used when the document may be
printed and has slight compromises between sharpness of images
and file size. It is set for Acrobat 5.0 compatibility,  reduces any image
over 225 dpi to 150 dpi and includes fonts.

The Highest Quality setting is for documents which need to be
printed with quality on a desktop printer.  It is set for Acrobat 5.0
compatibility,  reduces any image over 450 dpi to 300 dpi and includes
all fonts.

The Press setting is for the highest quality commercial printing. It is
set for Acrobat 5.0 compatibility,  reduces any image over 450 dpi
to 300 dpi  but uses maximum quality compression, includes fonts,
and doesn't change color from the settings set in the application.

When you change a setting,  Acrobat prompts you to name and
save it, after which it shows up in the list of presets.  

Adobe PDF Page Size

The last menu on the print dialogu allows you to select page size if
you are using something other than letter size paper.  If you are
creating a PDF file from a tabloid size document and this window
is set to letter, it will only reproduce the top left letter sized area of
the document, just as if you were printing the tabloid document to
letter size paper. There may be application specific settings in the
print dialogue that will scale the document to whatever paper size
is selected, if, for example,  you wanted to make handouts of a poster.

Click OK to create the PDF file

After choosing the settings appropriate for your use, click OK to
return to the print dialogue, set any application specific settings and
click OK again. A standard file dialogue box will appear with the
original file name of the document (except with a .pdf extension),
prompting you for the location to save the new Acrobat PDF
document.

The checkbox for View Acrobat PDF on the Adobe PDF Settings
tab in the Properties dialogue box is checked by default. so Acrobat
should launch automatically and display the file.
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Including fonts increases the size of the file. If the reader has
the fonts installed on their computer, Acrobat will use those
fonts, therefore it's unnecessary to include them.

If fonts are not included and they are not installed on the
users computer, Acrobat will substitute it's own fonts.  The
formatting of the page remains remarkably consistent, but
the appearance of the font may be different. After you've
created a document without including the fonts, you can
uncheck the Use local fonts command under the View
menu to see what it looks like with the subsitution fonts.

If it's important that the page look exactly the same or if
using specialized cartography, mathematical or music fonts,
the fonts can be embedded in the document.

You can choose to Subset embedded font,  where only
those characters that are used in the document are included,
which reduces file size but then the document can't be
edited with the Text Touch-up tool in the full version of
Acrobat.

There is a list of fonts which are nearly universal or so closely
match the Acrobat substitution fonts that are on a list which
Acrobat will never embed.  You can choose to add fonts to
a list which Acrobat will always embed or never embed
irrespective of the whether the Embed all fonts box has
been checked.

If you don't want to embed fonts at all in order to create
the smallest possible files, uncheck both Embed all fonts, and
Subset embedded fonts.

The Fonts panel includes an Embed All Fonts check box
that determines whether to include the fonts or not in a
document.
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Macintosh.

The ability to create PDF documents is built into the print
dialogue box of the Macintosh OSX operating system whether
you have Acrobat installed or not.  It creates slightly larger files
than using the Adobe PDF printer and there is no way to change
the characteristics of the resulting PDF file. Fonts are subsetted.
In some advanced graphics programs which include the ability
to export a file as PDF,  this function may be disabled (Adobe
Illustrator and InDesign), or simply won’t work (Macromedia
Freehand).

The options available in the print dialogue will vary with different
applications, but the Save as PDF button will always be at the
bottom

Printing to Adobe PDF

If you have Acrobat Standard or Professional installed, Adobe
PDF will be included on the list of printers.

When the Adobe PDF printer is selected, the menu of printer
characteristics will include PDF Options.

A menu of the preset options for your PDF file (see Setting
Characteristics on the previous page) will appear as well as an
After PDF Creation menu to choose whether to launch Acrobat
or Acrobat reader to check the file.

You cannot edit the settings from the print dialogue box.

The settings can be edited and new options placed on this list
by launching the application Acrobat Distiller (which should be
located in the same folder as Acrobat Professional or Standard)
and choose edit PDF settings from the Settings menu. (see the
previous two pages.)

If you select Acrobat or Acrobat Reader from the After PDF
Creation menu in the PDF Options dialogue, that application
will launch and display your file after you click print. The default
is to do nothing.

Finish by saving the file

Click the Print button. A standard file dialogue box will appear
with the file name of the original document with a .pdf extension,
prompting you for the location to save the new Acrobat PDF
document.
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Creating PDF's from paper documents.

Scanning directly into Acrobat

You can scan pages directly into Acrobat if your scanner came
with a Photoshop plug-in (most do and it’s normally setup when
you install the software that came with your scanner )

Acrobat 7 has new features that make scanned paper documents
searchable, copyable and at least partially accessible. Some of
these features don’t alway work perfectly,  with complex page
layouts, but they will generally give you the smallest file size with
at least a partially accessible document.

This process will be more accurate with a clean copy that is
place in the scanner straight.

From the File menu select Create PDF or from the Tasks toolbar
select Create PDF, and then From Scanner
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If you only have one scanner it will appear on the Device menu.
Some digital cameras and camcorders may appear to Acrobat
as scanners so you may have to pull down the menu to find
your scanner.

The Scan menu determines if the resulting PDF document will
be single or double sided.  If your original is double sided,  you
will simply be prompted to turn it over and whether you want
it placed in the PDF as the front or back of a page.

Under Destination, you can choose to open a new document
or add the scanned page to a currently open document.

The next two check boxes determine if you want Acrobat to
perform Optical Character Recognition, which converts the
page into searchable, copyable, accessible text. Unless the page
is only an image and has no text, leave both of these checked.

There are some Settings for OCR

The first chooses the language the text is in.  The second, PDF
Output Style,  gives you a choice between Searchable image,
which leaves the actual scanned image and adds the text in a
layer behind the image, or Formatted text and graphics, which
deletes the image, leaving only the text layer.

Formatted text and graphics can potentially reduce the file size
of the resulting PDF, but can negatively affect the appearance
and formatting of the page and often doesn’t actually create a
smaller file. Leave this setting at Searchable Image.

The last menu Downsample Images determines what the final
resolution of the image is.  In order to reduce file size, select
Medium (150dpi).  If file size is not an issue, leave this at Low
(300dpi) for an image that prints sharper.

Click OK to return to the Create PDF from Scanner dialogue

Click OK to return To the Create PDF from Scanner dialogue.

When you click scan, the interface for your scanner will be
launched and you can select the type of image, size and resolution
of the image.

With Acrobat’s adaptive image compression, it doesn’t make
much difference in the file size whether you choose black and
white, grey scale or color.  An image scanned as color will
probably look better on screen and print better.

Set the Resolution to 300 dpi.  Lower resolution can negatively
impact the accuracy of the Optical Character recognition.

With some scanner interfaces, you may have to find a link that
allows you to adjust the quality of the scanned image or choose
advanced settings.

After making the appropriate settings on your scanner interface,
click Scan (or whatever command your scanner uses to actually
start scanning.  The scanner will scan the page and ask if you
want to scan more pages or if you are done.  When you click
done, you will return to Acrobat.  It may take a while for Acrobat
to perform the Optical Character Recognition.

If you don’t need Optical Character Recognition

Scan at 300 dpi anyway.  With Acrobat’s adaptive image
compression, it actually makes a smaller file at 300 dpi than it
does at lower resolution! (note: if you’re doing Optical Character
Recognition as outlined above, the final downsampling to 150
dpi does reduce the file size)

Improving Accessibility

Acrobat files created by Optical Character Recognition don’t
always divide the page into correct areas of text and figures or
assign the correct reading order to parts of the page.  These
pages as well as pages done by creating PDF’s directly from the
original application don’t have alt tags for images.

You can correct some of these problems with the Touch up
reading order command found under the Advanced menu, off
the Accessibility submenu.

To add Alt tags to figures, when in the Touch up reading order
mode, control-click on the figure and select Edit Alternate Text
from the pop-up menu.
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Adding additional image files to the PDF

Use the Insert command (see next page).  The procedure is
the same.

If text is part of the image
file and you want to create
a Searchable Image
document, you can use the
Recognize Text using OCR
command under the
Document menu after you
have opened it as a PDF.
You will be able to choose
options similar to the Create
PDF from Scanner
command.

Recognize text using OCR will
not work with images that are lower that 144 dpi, and will be more
accurate the higher the resolution.
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Opening an existing scan as an acrobat file

From the File menu select Create file or from the Tasks toolbar
select Create PDF, and then From File.

A standard file dialogue box will appear.

Navigate to the location of the file you wish to convert.  At the
bottom of the dialogue select the type of file you wish to convert
to PDF. Only that type of file will appear on the list.

There will be a settings button that will give you options for
different types of files.

The defaults for these settings are typically set to apply medium
levels of compression to images without affecting image quality.
The file size reduction can be signficant.

Text created by OCR in Acrobat can be copied into other
applications (See Copying from Acrobat files, p. 10), but it places
a hard return at the end of every line.  The text portion of
an Acrobat file can be Saved as a Microsoft Word document
with the paragraph breaks in the proper place. However,
some files, including Searchable Image files created in Acrobat,
the export to Word doesn’t always work.

If you want to get the text out of Word with the paragraph
breaks in the proper place, first save the Acrobat file as Text
(Accessible).  This format puts a hard return at the end of
the every line, but also puts two hard returns at the end of
every paragraph.

Open the text file in Word.  You may have to change files of
type in the file dialogue to All Documents or Text files.

Once the file is open in Word, select Replace under the Edit
menu.

First in the Find what window, type ^p^p (^ is the upper
case of the 6 key).  In the Replace with window, place some
symbol which doesn’t exist in the document.  I usually use
the vertical bar |  (Upper case on the \ key) and click Replace.
This will mark the location of the paragraph breaks

Then, in the Find what window, type ^p,  clear the Replace
with window, and click Replace. This will remove the paragraph
breaks at the end of each line.

Finally, in the Find what window, type the symbol you used
in step 1, and in Replace with type ^p.  This will restore the
paragraph breaks at the end of the paragraphs.

Transferring text from Acrobat to Word.

Creating a PDF from a Web page

From the File menu select Create file or from the Tasks toolbar
select Create PDF, and then From Web Page.

You can enter a URL or browse to an HTML file you have saved
on your hard drive.

You can choose to save only the page you’re on, or the whole
site.  Be careful about choosing the whole site. Pages may not be
in the order in which links are followed and may include more pages
than you expect. When clicking on a link in a PDF from a web page,
you have the option of adding that page to your PDF.
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Viewing and modifying Acrobat files

There are several products in the Acrobat Family, and they all
share a similar interface, differing in how they create and modify
Acrobat files.

The free Acrobat Reader, downloadable from
http://www.adobe.com/products/acrobat/readstep2.html allows
viewing of any PDF file, copying text and graphics from a PDF
file, saving a copy of a PDF and filling in forms. The content of
the filled-in form cannot be saved with the free reader.

Acrobat Standard adds the ability to create PDF files from any
application, combine and divide PDF files, set certain types of
security and save filled-in forms.

Acrobat Professional adds the ability to create forms which
includes documents that can be electronically signed.

Zoom toolbar Help toolbar
Access special help topics

Rotate toolbar

Scroll bars scroll through the
entire document, not just the
page you’re on.

Step through pages one
at a time or enter a page
number and go directly
to that page.

Clicking the Pages tab will
display thumbnail images
of the pages in the
document. Clicking on a
thumbnail will take you to
that page
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Commands for adding,
deleting, replacing and
otherwise modifying files
are found under the
Document command

Modifying a PDF file

You can specify where in the document you want the new
document to be inserted.

All pages of multipage documents will be inserted.

Extract

You will be prompted for which pages you wish to extract.  Extracted
pages appear as a new document titled Pages from [original file
name]. You have to save the new file in order to keep it.

You have the option to delete the extracted pages from the
original document if you’re dividing one PDF into several.

Replace

You will first be prompted for the file from which to get the
pages which will replace those in the original file, with the same
options you have with Create from file or Insert.

Rotate pages

Individual or multiple pages can be rotated.

You can choose to specify only certain formats of pages.  For
example, if you had inserted several landscape pages into an
otherwise portrait format document, you could specify to only
rotate those landscape pages.
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Insert

Thiis will launch a
standard file dialogue
box.  You can choose
to insert other PDF’s
or an image file.  Select
the file type at the
bottom of the file
dialogue box.

You are then prompted for which pages you wish replaced and
which pages in the other document you wish them replaced
with.

If the page being replaced has form fields (see Creating forms
in Acrobat p. 12), only the underlying page is replaced, the form
fields are retained.  If the PDF file the page was replaced from
has form fields, those form fields are not included.  If you wish
to replace a page with a page with form fields from another
document, use the Insert command and Delete the original
page you wish replaced.

If you have created form fields in a document , replace pages
will only replace the underlying page. The form fields will be
unaffected.

Delete 

You will be prompted for the pages you wish to delete.

Clicking on the Pages tab at the left side of the screen will
display thumbnail image of the pages in the documents. Holding
down the Shift key while clicking on them will selected multiple
pages.  The delete dialogue will then include the option of
deleting selected pages.



Creating files and forms in Adobe Acrobat Version 7

Crop pages

One or more pages can be
cropped in order to preserve
just a section of a page, to
remove excess borders or to
make a uniform page size of a
document assembled from
different sizes.

When cropping values are
entered, in addition to the
thumbnail display on the
dialogue box, guidelines appear
on the full size display.

In addition to specifying the
crop by measurement with this
command, there is a Crop tool
on the Advanced Editing menu,
found under the Tools menu
with which you can visually
specify the area to be retained
by clicking and dragging.

Multiple pages can be cropped
to the same specifications.

Rearranging pages

Click the pages tab on the left side of the screen
to reveal thumbnail images.

When you click and drag a thumbnail image, a
light blue line appears between pages as you
drag up or down. When the line is in the new
location you wish the page to be, release the
mouse button and the pages will be rearranged.

Multiple pages can be selected and moved by
also holding down the shift key while you’re
clicking to select them.

This
page

moves
to here
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As illustrated in this
segment pasted into
a Microsoft word
document with the
formatting codes
displayed, every line
from an Acrobat
document comes in
as hard return.
Otherwise it comes
in as rich text, with
font, size and style
intact.

See Transferring text from
Acrobat to Word, p.6 

Exporting text and images

There are options in the Save as dialogue to save all text in the
entire document as an RTF (rich text) or Unformatted Text file.

Under the Advanced menu is the Export all images command
which will save all images in the document as separate image
files in a variety of formats.

In some documents these functions won’t work correctly.  In
that case, image can be copied as above.

See Transferring text from Acrobat to Word, p.6 

Searching and editing text

Text is searchable with the Find command under the Edit menu

You can do minor edits of text in an Acrobat file. Under the
Tools menu, off the Advanced Editing submenu, choose Text
touch up tool,  If you have select multiple lines to be edited,
you need to place hard returns at the end of each line to wrap
to the next line.

The Text touch up tool will only work if the entire font has
been embedded in the document, or if you have the font
installed on your computer.

If the document is text-based, you can copy from it and paste
into other applications.

On the Basic toolbar there are two
selection modes, for Text,  and Image.

(Copying can be done with Acrobat
Reader)

Select text

In the Text mode, text
is selected as in an
other text-based
application.  Click and
drag over it and the
text will be selected
following the normal
flow of columns.

To copy, from the Edit
menu select Copy, or
use the keyboard
equivalent Ctrl-C in
Windows or Cmd-C
on a Mac.

Select Table

If the text you wish to copy is in tabular format, when
you place the cursor over it when in the Copy text
mode, the cursor will change to the table icon

Click in the table to select the entire table, or click and drag to
select only a part of the table.

To copy, Control click and select Copy table.

Copying from Acrobat files

The selected area can be pasted into another application
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Select Image

Click on the Select image icon.  The cursor will change to a
cross hair. If you place the cursor over an area that Acrobat
recognizes as an image, click and the image will be copied
to the clip board. If you click and drag, only the area you
indicated will be copied.
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Bookmarks

Click the Bookmarks tab to open the Bookmarks pane.

Under the Bookmark menu, select New Bookmark.  A book
mark will appear as Untitled. You can double click on the name
and edit it. If you go to another page and click on that bookmark,
it will return you to the top of the bookmarked page.

If you choose Text select tool, select some text and then New
Book mark, the new bookmark appears with the selected text
as it’s name.

To create a bookmark on an image, with the Text select tool,
drag out an area, hold down the Control Key (Windows) or
Command Key (Macintosh) and release the mouse button.
Then select New bookmark.  It will appear as untitled, because
even if you select an area in which there was text,  it was just
a picture of the text.

You can edit the name of the bookmark by double clicking on it.

When you select the book mark from another page, it will take
you to the area that was selected when you created the
bookmark.

Bookmarks return you to page magnification in which bookmark
was created.

To rearrange bookmarks, click on the
bookmark and drag.  If you drag the
bookmark to the right of another
bookmark icon, it will become nested
under that bookmark. Plus and minus marks open and close
nested bookmarks.

If you had used style designations for headings when creating
documents in some programs, such as Microsoft Word or
Adobe InDesign, bookmarks may be created from those styles
when you create the PDF.

Links to other documents & web sites.

Under the Tools menu,
off the Advanced Editing
submenu, select Link
tool.  The Link tool also
appears on the
Advanced Editing toolbar
if it is displayed.  Click
and drag to select an
area.
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After the link is created, double click on it to modify it’s appearance.
You can choose to have links indicated by a visible rectangle.
One of the choices of styles for visible rectangle is underlined,
similar to the way a link is indicated on a web page. Note that
the underline style is just a line at the bottom of the area you
have selected, not an underlining of the text. The default color
is black, but you can change it to blue to mimic a web browser.

If you choose to not have links outlined (invisible rectangle)
they are not indicated in any way except that the cursor turns
into a hand with a pointing finger when you move over it.

Note: Links you have created in the original Word document will
not be active but will still look the way they were in the original
document.

Several options appear which includes several types of link
actions including linking to other files or web sites.

It the user is working on Acrobat Standard or Professional, when
they click a link to a website, they can choose to open it in
Acrobat or Web Browser.  If opened in Acrobat, it will convert
the page to a PDF which can be saved.
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The Forms toolbar can
be displayed to keep the
Forms tools accessible.

Each type of form field
has a tool used to create
and modify tools of that
type.

To create a form field, select the tool. The cursor will change to
a cross hair.  Click and drag out the area which you want the
field to fill.

Only Acrobat Professional can create forms. With the free
Acrobat Reader, forms can only be printed or saved as an
empty form.  Filled-in forms can be saved with Acrobat Standard
or Professional.  Data can be submitted electronically with
Acrobat reader but requires some server side software to
receive and store the data and may have other requirements.
See Submitting forms . p.15.

Create the underlying form

First you have to create the form in whatever application you
are familiar with as though it would be filled in by hand, and
create a PDF file of it.  You could also scan an existing form if
you don’t have the original file that created it.

Make sure the user will know where to fill in a text field.  For
short answers, you can use a line like on any form.  For longer
responses it might be better to put a box around it.  You can
add borders and check boxes as properties of a form field, so
you don't have to draw these in your original document.  Be
careful on how you phrase instructions so the user knows what
to do to fill the form in onscreen and submit it on line if it's set
up that way.

Keep in mind that text fields are all rectangles and can't have
an indent.  If you ask a short question, you can't have the text
field begin on the line the question is on and then wrap to the
beginning of the line below it.

Forms tools and toolbar

In order to create form fields, from the Tools menu, from the
Advanced editing submenu, select Forms to see the tools
available to create form fields.

The cursor becomes a cross hair and you click and drag out an
area to define the field. When you release the mouse button,
the area is indicated and a dialogue box opens in which you can
specify properties of the field. which are grouped under seven
tabs. When you begin the Appearance tab is displayed but
thereafter the tab you were on when you closed the dialogue
will be displayed when you modify a field or create a new one.

Appearance field properties

You have a choice whether to have a border or fill (or not) and
choose the width and color of the border if one is used. If you
have created a line or box in your original file to indicate where
text is entered, choose no line. Use lines and fill colors sparingly
to prevent your form from appearing cluttered and busy. If you
do place a border on a field, use a thin border and a lighter shade
of grey. You may wish to emphasize special fields with a light fill
color or a thicker border.

You can choose the typeface and the size and color in which
text entered in a field appears.  The top of the list includes faces
that Acrobat considers universally available.  If you choose any
other typeface, it has to be embedded 100% or installed on the
user’s computer in order to be displayed correctly.

Button

Check
Box

Combo
Box

List
Box

Radio
Button

Text

Digital
Signature

Text fields

One of the most common fields is the text field, where you
want the user to fill in text
or numerical information.
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 Acrobat 7 for Windows includes a new application,  Adobe
LiveCycle Designer (It shows up on the All Programs menu
as just Adobe Designer) that creates Acrobat forms from
scratch and allows editing of form fields and all other text
in a form and may include form functions that aren’t
available in Acrobat. Forms can still be created and edited
in Acrobat in the manner for previous versions. Existing
forms can be imported into Designer, but can then no longer
be edited with Acrobat. The following directions are for
working only in Acrobat and do not include directions
for Designer.

Creating Forms in Acrobat
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General field properties

By default the field Name will be the type of field and a serial
number.  You may wish to change the field name to identify the
contents of the field.  With special server side resources, data
can be electronically submitted from a PDF form. Field names
can identify the data entered. (In previous versions, entering a
unique field name was required.)

If two text fields have identical names, when one is filled in the
other will also be filled in.  This can be used to repeat a user’s
identification on multiple pages or carry the results of calculations
from the bottom of one page to the top of the next.

If you enter something in the in the Tooltip box it will pop up
as a note when the cursor is held for a second over the field.

You can choose to make the field Visible or not and choose
whether it is Read Only so the user can't change it .

For example, you may have respondents categorized and don't
want them to be able to alter that.  You may not want them to
know how they are categorized so you might want the field
hidden.  Text files can be limited to numbers and the values of
fields can be calculated (See Calculate on the next page).  You
may not want the user to modify some of the values (like a
price) or see the basis or result of a calculation.

Options also exist for making a field visible, but doesn’t print
(e.g. instructions or warnings) or not visible but that do print.
(e.g mailing label, user category).

Options field characteristics

You can choose to Align the text the user enters left (most
text) right (most numbers and some text columns) or centered.

You may wish to start with a standard value.  The Default Value
will appear in the field.  In order to change it the user has to
select the text and type over it.

If Multi-line is checked, text will wrap to a second and subsequent
lines.

If Scroll long text is checked, the field will accept more text
than the size of the field will hold.  If Multi-line is not checked,
text will scroll to the left and will disappear out the left side of
the field. In order to review the text that has been entered, the
user must use the arrow keys to move the cursor.  When the
cursor has move to the left side of the field, the text will scroll
back into view.

If Multi-line has been checked, text will wrap to second and
subsequent lines.  When the area of the field has been filled, it
will scroll off the top and a scroll bar will appear on the right
side of the field, allowing the user to review entered text.

If Scroll long text is not checked, only as much text as will fill
the field can be entered.

Allow Rich Text Formatting allows the user to apply style
changes such as bold or italic text, super or subscripting or
change the typeface or it’s color. In order to actually make these
changes, the user has to display the Text Field Properties toolbar.
If the toolbar is displayed and a field doesn’t allow Rich Text
Formatting, all the functions on the tool bar will be greyed out.

Entering a value for Limit of characters will only allow that many
characters entered, even if the field will accomodate that.  Useful
when you want to limit numerical entries to standard numbers
like product IDs.

When Password is checked (i.e. the entry in the field is a
password) , entered text appears as asterisks.
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You may wish to select a different typeface from that in which
the original form was set in order to distinguish entered
information.

It’s preferable to choose a specific Font Size and make sure
the field is large enough to accomodate the information you
intend to be entered.

If you choose Auto for the Font Size, Acrobat will begin with
a size based on the size of the field and as the field becomes
filled, reduce the size of the type until it’s unreadable.

You may also select a color so that entered text is clearly
distinguished from the form itself.  Be sure to choose a dark
enough color to be legible.
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Check box fields

Check box fields are for lists where more than one option can
be selected.

Appearance  The default is to draw a border to actually create
the box to check.  If there are boxes already on your form, you
can select No Color.

Options:  You can choose the style of what appears (X, filled in,
check mark) when the box is checked.

You can give it a value.  The default is yes, but could be other
text, or a numerical value that could be calculated in another
field (a discount for belonging to a group, for example).

Format field properties

You can specify specific formats of entry, such as distinguishing
numerical entries in anticipation of calculations, or limiting entry
to specific formats such as social security number.  If the user
attempts to enter something other than the specified format in
the field, nothing appears and Acrobat beeps.  Version 7 of the
free reader displays a message that the entry doesn’t match the
specified format, but doesn’t indicate what the format is.  Use
instructions and brief descriptions to assist your users.

Validate field properties

You can limit entries in ways not specified under format, such
as limiting numerical entries to certain ranges.   If the user
attempts to enter data outside the range, they are prompted
with a message that specifies the allowable range.  You can also
write custom Javascripts to specify allowable entries.

Calculate field properties

For fields with numerical formats you can automatically add,
multiply, average or select the minimum or maximum of a
specified number of other fields.  For example, you could multiply
a price in a read-only field by a user-entered quantity to
automatically fill in a total cost field.   You can create hidden
fields to supply values for calculations.

More complex calculations can be made using spreadsheet like
formulas or writing custom Javascript.

Modifying, moving, and resizing fields

When the appropriate tool is selected, fields created by that
tool will display a border with handles.  Double clicking on the
field will open the Properties dialogue.  Click and dragging will
move the field, and clicking on a handle and dragging will resize
the field.

Radio Button fields

Radio Buttons are used where users can select only one option
from several choices.  Very similar to Check boxes except that
they must all have the same name, and must have different export
values.

Combo Boxes and List Boxes

Also allow the user to choose one of several options.  Combo
boxes appear as a pull down menu.  In List Boxes all the options
are visible, but the user has to click on the appropriate choice
which is then highlighted. If the list of items in a List Box field
is larger than the field, scroll bars will appear.

Digital Signature fields

Signature fields can potentially be used like any signature, but
require some sophistication and understanding of the process
by the user as well as other communication via email to verify
the signature.

Duplicating,  aligning and positioning fields

Under the Tools menu, off the Advanced Editing submenu,
select the Select Object Tool

Right click (Windows) or hold down the Control key and click
(Macintosh) and a menu of items appears that allows you to
create identical duplicates of a field, but with unique names.

You can select multiple fields with the Select object tool by
holding down the Control key (Windows) or Option key
(Macintosh) and clicking.  The right click (Windows) or Control
click (Macintosh) menu will have options for aligning or evenly
distributing fields when multiple fields are selected.

You can display a grid to help position fields by selecting Grid
under the View menu.
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Submitting forms

With Acrobat Reader you can only print a filled in form. It cannot
be saved.  With the full version, the form can be saved.

Form data can be submitted electronically, but this requires
software residing on a server.  At UW Oshkosh we have two
methods–"mailto" which sends an email containing the data to
a specified address and "write to" which writes the data to a
specified delimited file which must be created specifically to
receive the data.

In both cases in order to submit the form the user must be
using the full version of Acrobat,  Acrobat reader 6 or higher
or version 4 or 5 of the reader as a browser plug-in.  If using
the standalone version 4 or 5 of the reader, a submit button
won't work.

If the user just clicks on a link on a web page the browser will
automatically launch the reader as a browser plug-in if it's
installed.

If the form is supplied as a file (on a CD),   It would be safest
to place a link to the form file on an HTML page, so when the
user clicked on the file icon, the browser would launch. The user
would then click on the link to the PDF in order to launch the
plug-in version.

If the user double clicks on the file icon of the original PDF, the
stand alone version of the reader will launch, and if it’s version
4 or 5, the submit button will not work.

Of course, the computer must be connected to the internet in
order to submit data.

Setting up a form that can submit data.

Submit button field.

Create a Button field

In the Options panel you can specify the text that appears on
the button,
such as "Click
here to
submit your
information"
or use a
graphic icon
you've
created in
another
applicaton as
a submit
button.

On the
Actions
panel, choose
Submit a
form as the
action, and then click Add. (A button can have several actions)

Notice that you can select only specific fields to be returned.
With both Mailto and Writeto, even if you check Include empty
fields, unchecked check boxes will not have values returned. In the
delimited file created by Writeto, it will skip over empty check box
fields, causing your data to not always be entered into the same
columns.

The URL is the address of the server side program which will
recieve the submitted data.

For mailto.cgi, it is http://www.uwosh.edu/cgi-bin/mailto.cgi

For writeto.cgi, it is  http://www.uwosh.edu/cgi-bin/writeto.cgi

For Export format for both server programs, HTML is the only
type of data they will deal with.

Fields required to submit data

These fields can be filled in by the user or can be read-only so
they can’t be changed by the user and can also be hidden.

For mailto.cgi:

You must have a field named to. The default value is the email
address you wish to receive the data.

You should have a field named from.  This is what will appear
in the From field in the email.  If it is not a valid email address,
it will appear as unknown@unkown ([text you filled in])

You should also have a field named subject. This will appear in
the subject line as “Webmail - [text you filled in]

For writeto.cgi:

You must have a field named to.  The default value is the file
name of the text file into which the data is to be written.  You
have to arrange with Academic Computing (Dan Pederson) for
the creation of this file and ftp access to the directory in which
it is stored on the main UW Oshkosh web server.

The Submit Form Selections dialogue will appear.
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vs HTML
To return data requires
• Acrobat Reader 4.0, 5.0  or 6.0- operating as

browser plug-in
• Or full Acrobat or Reader 6.0- operating as

a stand-alone application

Any browser 3.0 or better

Two step creation
• Layout in original application
• Fields added in Acrobat

Created entirely in HTML editor

Data returned by alphabetical order of
field names.

Data returned in order they appear
in form

Can calculate fields based on values in
other fields.

All fields must be filled in by user or
calculated  by inserted Javascript
You could do calculations later in
database, but user wouldn’t see them

Not all fields have to be returned All fields returned

Can be saved by user if using full version of
Acrobat.
Cannot be saved using just the Reader.

Must be filled in all at one session

Unchecked “Check box” fields can be
returned but it’s a little complicated.

Unchecked “Check box” fields can be
returned but it’s a little complicated.

Fields can overlay graphics Fields cannot overlay graphics

Format on screen and print always
exactly the same for all users on all
platforms. Matches existing printed form
exactly.

Varies depending on
•  browser
•  browser prefs
•  monitor

•  window size
•  printer specs

Acrobat
O N  L I N E  F O R M S

Nick Dvorack • dvoracek@uwosh.edu • 920-424-7363 •  http://idea.uwosh.edu/nick/handouts.htm

Forms that return data can be put on-line as either Acrobat
Files or embedded within a web page using HTML forms
command, normally edited with a tool such as Macromedia

Dreamweaver or Microsoft FrontPage. This table illustrates some
of the differences in the two methods.
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